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Advanced Excel Topics  
Goal: to make a spreadsheet that shows an in inventory, with trends in sales, and reminders of when to order.  
You will also test giving all employees a 5% raise, and compare expenses to sales to see if you can afford it. 
You will also freeze some items, to allow you to scroll down the page and still see the column headings. 
You will also make some areas of the worksheet protected, so entries are not accidentally changed, and finally explore 
print and sort options. 

Creating Sheet 1 
Our business is selling computers, monitors, tablets, and something else that you pick. 
We’ll start with 0 inventory, get various amounts in, and sell various amounts for three months. We’ll need to see how 
many we have sold, and make a quick spark chart to show  us a trend. 

 

Note: I selected Row 1, right clicked, Format cells, Alignment, and chose 45 degrees. 
See also Formatting cells https://edu.gcfglobal.org/en/excel/formatting-cells/1/ 
 
For the last line, you should use different numbers, and something aside from Batteries. 
Autosum just the sales in each row, =SUM(D2:F2)  to generate a current inventory. 

 
You could autofill this formula down to get the remaining inventory, or do each line individually. 
 
Now, take January Deliveries, and subtract from it the Sales, to get current inventory. 
The formula for the first row is =C2-G2 

 
You could autofill this formula down to get the remaining inventory, or do each line individually. 
 
See also Intro to Formulas https://edu.gcfglobal.org/en/excel/intro-to-formulas/1/ 
See also Creating more complex formulas https://edu.gcfglobal.org/en/excel/creating-more-complex-formulas/1/ 
See also Functions https://edu.gcfglobal.org/en/excel/functions/1/ 
(Autosum is the most commonly used function) 
See also Groups and subtotals https://edu.gcfglobal.org/en/excel/groups-and-subtotals/1/ 

https://edu.gcfglobal.org/en/excel/formatting-cells/1/
https://edu.gcfglobal.org/en/excel/intro-to-formulas/1/
https://edu.gcfglobal.org/en/excel/creating-more-complex-formulas/1/
https://edu.gcfglobal.org/en/excel/functions/1/
https://edu.gcfglobal.org/en/excel/groups-and-subtotals/1/
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You should have something like this: 

 
The green triangles indicate that the formulas nearby are different than this formula. 
This can be handy later, when trying to track down a problem… just ignore for now. 
 
Rename the Workbook sheet. 
Right click the workbook tab called Sheet1, at the bottom, and select Rename 

 
Rename Sheet1 to Inventory, and save the file as yourname-business.xlsx 

 
Your screen may differ. 
See also Working with Multiple Worksheets https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/ 
 
Charts 
In an earlier activity, you added basic charts. 
See also Charts https://edu.gcfglobal.org/en/excel/charts/1/ 

Spark charts   
To get a small chart ( a chart that actually fits IN a cell) that shows a trend, I am going to use a SparkChart. 

I have skipped over a few columns, and added the label Trends in cell K1. 
I next select JUST the sales numbers for row 2, and go to the Insert Tab, and in the Charts group select Line 

Your screen may vary slightly 

https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/
https://edu.gcfglobal.org/en/excel/charts/1/
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When you select Lines, you get this dialog box… we have already selected the range, now just tell it where the chart will 
go… in our case, I will type in K2 

 

Repeat the process, putting charts into K3, K4, and K5 to get the following

 

Note: Computer sales are flat, Monitors are trending up, Tablets are trending down, and in my case, the last item is 
trending up.  

Recall, you should have something besides Batteries, and your numbers for the last row should differ. 

See also a great video on this subject at 
 https://support.office.com/en-us/article/use-sparklines-to-show-data-trends-1474e169-008c-4783-926b-5c60e620f5ca 

More on Charts 
Aside from dragging your mouse to select a range for a chart, you can also hold down the Ctrl key, and add cells to a 
range that may not touch other cells. 

Example, in the earlier Budget activity, instead of just displaying the amount left over each month in the chart, I could 
have also added month names. 
Here is the original chart, based on 42A:42E

 

https://support.office.com/en-us/article/use-sparklines-to-show-data-trends-1474e169-008c-4783-926b-5c60e620f5ca
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Now, I will redo. I’ll select the chart and delete, then reselect A42:E42, but then also 
hold down the control key to include A33:E33 

 

Now I’ll insert a column chart based on both ranges. To include the Month names. 

 

See also 
https://support.office.com/en-us/article/create-a-chart-from-start-to-finish-0baf399e-dd61-4e18-8a73-b3fd5d5680c2 

Conditional Formatting 
Conditional formatting can color code a value based on a logical test. Maybe we would like to see inventory numbers 
below 6 to show up as red. Select the cells H2:H4, then select Conditional Formatting>Highlight Cell Rules>Less than… 

 

Fill in the value 6 

 in order to turn cells that are less than 6 Red. 

https://support.office.com/en-us/article/create-a-chart-from-start-to-finish-0baf399e-dd61-4e18-8a73-b3fd5d5680c2
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You can now easily see the cells where inventory may be too low, in our case, below 6. 

 
See also Conditional Formatting  https://edu.gcfglobal.org/en/excel/conditional-formatting/1/ 

If 
To get a warning when it might be time to order more stock, not just a color coded value, we can use what is called an  
IF statement. Do not confuse an IF statement, or Function, with “What If” which will be covered shortly. 
Based on a logical test, Excel can display a message depending on if the test result is true, or false. 
 

So we could set our reorder threshold to 5 for the computers, monitors, and tablets, and then have Excel display  
Order More or Inventory OK, depending on if the inventory number is above 5, or below or equal  to 5. 
 

The basic lay out in Excel is, logical test, value if true, value if false. 
So we would fill out H2>5 for the logical test, “Inventory OK”  for the value if true, and “Order More”  for value if false. 
Then we can also apply some rules to color code it, as well. 

To do this we’ll add a new label in M1, Inventory Status. 
Next, select cell M2, and click the fx  button, and search for IF. 

 
Click Ok and fill out as shown 

 Then click OK, repeat for M3 and M4, or autofill. 

https://edu.gcfglobal.org/en/excel/conditional-formatting/1/
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Now we now have two ways to quickly check the status of our inventory  
See also Functions https://edu.gcfglobal.org/en/excel/functions/1/ 

Starting Workbook Sheet 2, Salaries 
We are now going to enter 3 mythical employees, and figure out how much they make. 
If needed a new sheet, then add the following information on Sheet2 
See https://support.office.com/en-us/article/insert-or-delete-a-worksheet-19d3d21e-a3b3-4e13-a422-d1f43f1faaf2 
 
In A1 Employee Expenses 
In A2 Budgeted Salary 
In A3  Actual Salary 

Then add the following, starting in A5 

Employee Hours worked  Salary  Pay 
Fred  40   15   
Wilma  35   20 
Barney  37   18 
 
It is probably pretty hard to read these column headings, so click on the Gray Column heading  on Column A and drag to 
the right to select columns A:D. 

 
Hover above one of the lines seperating the columns until the cursor turns to a double sided arrow. 
Double click the line to AutoSize the columns, so the columns now hold the widest item in each column. 

  
Double click one of the lines separating the columns to AutoSize the column widths, now each column is big enough to 
hold the largest item in each column… 

https://edu.gcfglobal.org/en/excel/functions/1/
https://support.office.com/en-us/article/insert-or-delete-a-worksheet-19d3d21e-a3b3-4e13-a422-d1f43f1faaf2
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We could also click the line between columns and dragged to manually resize each column, or we could also have right 
clicked the selected columns, and gone to Column Width, and set each column. 

Now select A1:E1, right click the selection, and under Format Cells, go to the Alignment tab, and select Merge Cells. 

 

Now you can center the text, change the font face, color, fill color, etc. 

Let’s get back to work, and calculate our employees salaries, by multiplying hours worked by salary, putting the result 
under the Pay column. I’ll format salary and Pay as Currency, with the $ button on the home tab. 

 
Let’s also total Salaries using Autosum. 
See also 
Cell Basics https://edu.gcfglobal.org/en/excel/cell-basics/1/ 
Modifying columns, rows, and cells https://edu.gcfglobal.org/en/excel/modifying-columns-rows-and-cells/1/ 
Formatting cells https://edu.gcfglobal.org/en/excel/formatting-cells/1/ 
Understanding number formats https://edu.gcfglobal.org/en/excel/understanding-number-formats/1/ 

https://edu.gcfglobal.org/en/excel/cell-basics/1/
https://edu.gcfglobal.org/en/excel/modifying-columns-rows-and-cells/1/
https://edu.gcfglobal.org/en/excel/formatting-cells/1/
https://edu.gcfglobal.org/en/excel/understanding-number-formats/1/
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What if 
What is, is basically testing a scenario. I would like to see what the result would be if I gave everyone a 5% raise would 
be. Now I could just change the salary, and then use Ctrl+Z to undo, but I would like to save the results. 
 
First, I have decided my budget for salary is $2500, I’ll add that to B2. And I’ll add “Proposed Salary” to A4. 
I repeat the total calculated in D9 into B4 by simply typing in=D9 

 leads to   
If I change any salary, the results in column D will be updated, and that will reflect in the Actual Salary line. 
Now, let’s name this Workbook Actual Employee Expenses. Right click the tab and select Rename. 
 
To create my proposed salary I will copy Workbook Sheet2, and place the copy after Actual Employee Expenses. 
Right click the tab, and select Move or Copy. 

 

 
Make sure you select Create a Copy, and place it after the current sheet. If the new sheet goes to the wrong place, just 
drag it to where you want it. Rename this new sheet to Proposed Employee Expenses. 
Now let’s make a reusable sheet. I don’t want to just change the values, I want to be able to test multiple percentages. 
For this, I’ll use an absolute reference. When autofilling, something like =A1*B1 down, the next cell down would be 
=A2*B2.  
But what if I want to keep using A1 and not let that value change? I would change to formula to =$A$1*B1 
and when I autofill down, the next row would keep using A1 but increment the other value to B2. 
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Absolute References 
See also  
Relative and absolute cell references https://edu.gcfglobal.org/en/excel/relative-and-absolute-cell-references/1/ 
 
So if I autofilled =$A$1*B1 down, I would wind up with cells that contained  
=$A$1*B1 
=$A$1*B2 
=$A$1*B3 
=$A$1*B4 
 
So I am going to add the following on the Proposed  Employee Expenses, in cells A11 and B11 
A11 Proposed Raise B11 .05 

 
 
Now, in F5, I’ll add a new label, After raise. 
Now I will add the following formula to F6 =(D6*$B$11)+D6 
D6 is Fred’s current Pay 
$B$11 refers to B11, the proposed raise amount, but since I added the $ before the column and $before the row to 
make it an absolute reference, a cell reference that will not change if I autofill down to quickly build the other formulas. 
The formula first does the raise amount, then adds the raise amount to the current salary to get the proposed salary/ 

 
Hit enter to see that Fred might get paid $630. 
 
Select F6, and click on the small box to the lower right hand corner, the AutoFill button, and drag the box down to F8 
and let go. 
In F9 use AutoSum to calculate the proposed total wages. 

 
Now, in B4, type in =F9 
 

https://edu.gcfglobal.org/en/excel/relative-and-absolute-cell-references/1/
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I can see that this is below my Budgeted Salary value. 
WHAT IF if given them a 25% raise? 
Change B11 to .25 
See how all the effected values change? 

 
 
One last trick. select the Inventory sheet, and add the following info 
A9 Type in Current Sales 
A10 Type in Proposed Salary 
 
In C9 Type in 3000 and make C- and C10 formatted as currency. 
Now, select C10 and type an equal sign  = 
then select the Proposed Employee Expenses tab 
then click B4, the Proposed Salary value 
now hit enter 

 
 
The proposed Salary value should now display. If you click B10, you should see the full path to the cell reference;  
='Proposed Employee Expenses'!B4 
sheet name,   then an exclamation mark  ! then the cell reference… telling excel where to look for the value.  
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If you were to change the % raise value on the Proposed Employee Expenses tab, the math is reworked, and the result is 
then displayed on your Inventory sheet,  where you could do the math to see if you can meet expenses. 
 
See also What if https://edu.gcfglobal.org/en/excel/whatif-analysis/1/ 
Working with Multiple Worksheets https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/ 

Freeze  
I hate busy work, but imagine you have 300 employees, and 20 months’ worth of pay calculations. If you scroll to the 
right you no longer see the names, if you scroll down, you no longer see the month names. 
A solution to this is to freeze the top row and the first column. This is done by select the cell that is below the first row 
and to the right of the first column: B2 
Then on the view tab Select Freeze Panes 

 

Your screen may vary 
Now, if you scroll down the first row is frozen in place. 
Now, if you scroll to the right, the first column is frozen in place. 

See also Freezing Panes and View options https://edu.gcfglobal.org/en/excel/freezing-panes-and-view-options/1/ 

Printing ranges 
If you go to File>Print, Excel will try to print everything on the current page. 
 
If you only want to print a portion of the pages, select the portion you want to print, then go to Page layout, and select 
Print area. You can repeat the steps to change the print area, or add to the print area. 

 

https://edu.gcfglobal.org/en/excel/whatif-analysis/1/
https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/
https://edu.gcfglobal.org/en/excel/freezing-panes-and-view-options/1/
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Also, you can control what prints, and even set the print job to fit on one page with scaling. 

 

Page Layout and Printing https://edu.gcfglobal.org/en/excel/page-layout-and-printing/1/ 

More on Managing Workbook sheets, Protecting workbooks 
You can rearrange workbook sheets, copy workbook sheets, color the tabs on workbook sheets, as well as pull results 
from one sheet to a different workbook sheet. 

You can also select cells and protect them to keep from accidentally changing a value 
See Also 
Inspecting and protecting workbooks https://edu.gcfglobal.org/en/excel/inspecting-and-protecting-workbooks/1/ 
 
A bit more on passwords at https://www.microsoftpressstore.com/articles/article.aspx?p=2743760 

Deeper Dive in Excel 

Linking a Chart into Word or PowerPoint (you can do this in your Research Project) 
You can create a chart in Excel, then copy the chart into Word or PowerPoint… but if the data changes, the chart in Word 
does not, as it was a picture of the way the chart used to be. We call this embedding. What we want is to actually create 
a link to the live, working chart. This is done with what used to be called OLE, Object Linking and Embedding. 

Instead here is how we link rather than embed the chart:  
as usual, right click a corner of a chart in Excel and select copy; 
 
Switch to Word or PowerPoint and place your cursor where you want the chart to go. DO NOT RIGHT CLICK.  
This is one of the rare times Right Click is not the answer… 
 

https://edu.gcfglobal.org/en/excel/page-layout-and-printing/1/
https://edu.gcfglobal.org/en/excel/inspecting-and-protecting-workbooks/1/
https://www.microsoftpressstore.com/articles/article.aspx?p=2743760


Advanced Excel [Type text] 13 
 
Select the v arrow below Paste on the Home tab, and then select Paste Special...  

  
From here choose to Paste  link, and  
finally select Microsoft Excel Chart Object. 

 

 

Now, if the chart changes in Excel, it will also change in the other document, as it is not a picture of the chart, but 
actually the real chart.  

Pivot tables (required by the State, at least know the definition) 
A pivot table arranges and rearranges (or "pivots") statistics in order to draw attention to useful information. 
 
Microsoft says “A PivotTable is a powerful tool to calculate, summarize, and analyze data that lets you see 
comparisons, patterns, and trends in your data.”  
 
See 
https://support.office.com/en-us/article/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576 
See also Pivot tables https://edu.gcfglobal.org/en/excel/intro-to-pivottables/1/ 
See also Doing more with Pivot Tables https://edu.gcfglobal.org/en/excel/doing-more-with-pivottables/1/ 
 
 

https://support.office.com/en-us/article/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576
https://edu.gcfglobal.org/en/excel/intro-to-pivottables/1/
https://edu.gcfglobal.org/en/excel/doing-more-with-pivottables/1/
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A quick note on Time and Date 
If you wish to add the time and/or date to a spreadsheet, check out: 
https://support.office.com/en-us/article/insert-the-current-date-and-time-in-a-cell-b5663451-10b0-40ab-9e71-6b0ce5768138 

For information about how Excel stores dates back to 1900, check out  
https://www.myonlinetraininghub.com/excel-date-and-time 

Sorting Data 
Basic tips for working with data https://edu.gcfglobal.org/en/excel/basic-tips-for-working-with-data/1/ 
Sorting data https://edu.gcfglobal.org/en/excel/sorting-data/1/ 
Filtering Data https://edu.gcfglobal.org/en/excel/filtering-data/1/ 

R. Craig Collins ©2020 

Resources in One Place 
Excel Resources from GFCglobal https://edu.gcfglobal.org/en/excel/ 
Introduction https://edu.gcfglobal.org/en/excel/getting-started-with-excel/1/ 
Creating and opening Workbooks https://edu.gcfglobal.org/en/excel/creating-and-opening-workbooks/1/ 
Saving and sharing Workbooks https://edu.gcfglobal.org/en/excel/saving-and-sharing-workbooks/1/ 
Cell Basics https://edu.gcfglobal.org/en/excel/cell-basics/1/ 
Modifying columns, rows, and cells https://edu.gcfglobal.org/en/excel/modifying-columns-rows-and-cells/1/ 
Formatting cells https://edu.gcfglobal.org/en/excel/formatting-cells/1/ 
Understanding number formats https://edu.gcfglobal.org/en/excel/understanding-number-formats/1/ 
Working with Multiple Worksheets https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/ 
Using Find and Replace https://edu.gcfglobal.org/en/excel/using-find-replace/1/ 
Checking Spelling https://edu.gcfglobal.org/en/excel/checking-spelling/1/ 
Page Layout and Printing https://edu.gcfglobal.org/en/excel/page-layout-and-printing/1/ 
Formulas and Functions 
Intro to Formulas https://edu.gcfglobal.org/en/excel/intro-to-formulas/1/ 
Creating more complex formulas https://edu.gcfglobal.org/en/excel/creating-more-complex-formulas/1/ 
Relative and absolute cell references https://edu.gcfglobal.org/en/excel/relative-and-absolute-cell-references/1/ 
Functions https://edu.gcfglobal.org/en/excel/functions/1/ 
Working with Data 
Basic tips for working with data https://edu.gcfglobal.org/en/excel/basic-tips-for-working-with-data/1/ 
Freezing Panes and View options https://edu.gcfglobal.org/en/excel/freezing-panes-and-view-options/1/ 
Sorting data https://edu.gcfglobal.org/en/excel/sorting-data/1/ 
Filtering Data https://edu.gcfglobal.org/en/excel/filtering-data/1/ 
Groups and subtotals https://edu.gcfglobal.org/en/excel/groups-and-subtotals/1/ 
Table Styles https://edu.gcfglobal.org/en/excel/tables/1/ 
Charts https://edu.gcfglobal.org/en/excel/charts/1/ 
Conditional Formatting  https://edu.gcfglobal.org/en/excel/conditional-formatting/1/ 
Doing More with Excel 
Comments and Co-authoring https://edu.gcfglobal.org/en/excel/comments-and-coauthoring/1/ 
Inspecting and protecting workbooks https://edu.gcfglobal.org/en/excel/inspecting-and-protecting-workbooks/1/ 
Pivot tables https://edu.gcfglobal.org/en/excel/intro-to-pivottables/1/ 
Doing more with Pivot Tables https://edu.gcfglobal.org/en/excel/doing-more-with-pivottables/1/ 
What if https://edu.gcfglobal.org/en/excel/whatif-analysis/1/ 
  

https://support.office.com/en-us/article/insert-the-current-date-and-time-in-a-cell-b5663451-10b0-40ab-9e71-6b0ce5768138
https://www.myonlinetraininghub.com/excel-date-and-time
https://edu.gcfglobal.org/en/excel/basic-tips-for-working-with-data/1/
https://edu.gcfglobal.org/en/excel/sorting-data/1/
https://edu.gcfglobal.org/en/excel/filtering-data/1/
https://edu.gcfglobal.org/en/excel/
https://edu.gcfglobal.org/en/excel/getting-started-with-excel/1/
https://edu.gcfglobal.org/en/excel/creating-and-opening-workbooks/1/
https://edu.gcfglobal.org/en/excel/saving-and-sharing-workbooks/1/
https://edu.gcfglobal.org/en/excel/cell-basics/1/
https://edu.gcfglobal.org/en/excel/modifying-columns-rows-and-cells/1/
https://edu.gcfglobal.org/en/excel/formatting-cells/1/
https://edu.gcfglobal.org/en/excel/understanding-number-formats/1/
https://edu.gcfglobal.org/en/excel/working-with-multiple-worksheets/1/
https://edu.gcfglobal.org/en/excel/using-find-replace/1/
https://edu.gcfglobal.org/en/excel/checking-spelling/1/
https://edu.gcfglobal.org/en/excel/page-layout-and-printing/1/
https://edu.gcfglobal.org/en/excel/intro-to-formulas/1/
https://edu.gcfglobal.org/en/excel/creating-more-complex-formulas/1/
https://edu.gcfglobal.org/en/excel/relative-and-absolute-cell-references/1/
https://edu.gcfglobal.org/en/excel/functions/1/
https://edu.gcfglobal.org/en/excel/basic-tips-for-working-with-data/1/
https://edu.gcfglobal.org/en/excel/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel/sorting-data/1/
https://edu.gcfglobal.org/en/excel/filtering-data/1/
https://edu.gcfglobal.org/en/excel/groups-and-subtotals/1/
https://edu.gcfglobal.org/en/excel/tables/1/
https://edu.gcfglobal.org/en/excel/charts/1/
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Evaluation 

20 items, 5 points each 

 

Format 1st row to 45 degrees 

Column widths adjusted 

Added proper labels for Inventory 

Added approriate values for Inventory 

Added correct Autosum values for Sales 

Correctly created formulas for remaining inventory 

 

Renamed the worksheet 

Added proper splark line charts 

Added correct conditional formating 

Correctly added If function 

 

Correctly added Salary labels 

Correctly added Salary values 

Column widths adjusted 

First row merged and formatted 

Salary calculations complete 

Worksheet renamed 

 

Proposed Employee expenses copied and renamed 

Formula uses absolute references 

All formulas and cell references created correctly  

 

Proposed value transfered to Inventory sheet 
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